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Starting in version 11, QlikView has the capability to integrate with source control systems. In the initial release a
Microsoft TFS connector was introduced and a further connector for Subversion was added in SR1. The feature is
available when using QlikView Desktop.

A menu option in the File menu allows QlikView developers to connect a QlikView document to a source control
system. This feature works with the XML project files that QlikView Desktop can generate and offers basic
integration into third party source control systems.

QlikView 11 Source Control integration now ships with native support for Microsoft Team Foundation Server and
Subversion for source control.

To integrate TFS with Qlikview, we need the Microsoft TFS MSSCCI Provider software installed on the machine:
Below are the links where we can get the software version-wise:
= 2013 MSSCCI

https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundati
onServer20132015M

= 2012 MSSCI

https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundati
onServer2012MSSCC

= 2010 MSSCCl

https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundati
onServer2010MSSCC

NOTE: Only 32-bit version of MSSCCl is supported by Qlikview.

Installation folder is “C:\Program Files (x86)\Microsoft Team Foundation Server MSSCCI Provider\” as specified
below. Once installed, we must ensure that Team Explorer is configured to a TFS Server before continuing.

‘ﬁ! Microsoft Team Foundation Server MS5CCI Provider EI = @

Welcome to the Microsoft Team Foundation Server |—
MSSCCI Provider Setup Wizard

The installer will guide you through the steps required to install Microsoft Team Foundation Server
MSSCCl Provider on your computer.

WARNIMG: This computer program is protected by copyright law and interational treaties.
Unauthorized duplication or distribution of thiz program, or any portion of it, may result in severe civil
ar crirminal penalties, and will be prosecuted to the maximurm extent possible under the law.

Cancel < Back



https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundationServer20132015M
https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundationServer20132015M
https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundationServer2012MSSCC
https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundationServer2012MSSCC
https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundationServer2010MSSCC
https://marketplace.visualstudio.com/items?itemName=TFSPowerToolsTeam.MicrosoftVisualStudioTeamFoundationServer2010MSSCC

‘ﬁ Microsoft Team Foundation Server MSSCCI Provider EI = @

Select Installation Folder |—

4

The ingtaller will install Microsoft Team Foundation Server MSSCC Provider to the following folder,

To install in this folder, click "Mest". To install ta a different falder, enter it belaw ar click "Browse".

Folder:

C:AProgram Files (#86)4Microzoft Team Foundation Server MSSCC! Pr Browse...
Dizk Cost...

Install Microsoft Team Foundation Server MSSCCI Provider for yourself, or for anyone who uses
this computer:

@ Everyone
Just me
Cancel | | < Back | [ Mext > ]
f@ Microsoft Team Foundation Server MSSCCI Provider EI =] @
Installation Complete

Microzoft Team Foundation Server MSSCCI Provider has been successfully installed.

Click "Cloze" to exit.

Pleaze uze Windows Update to check for any critical updates to the MET Framework.

Cancel < Back

After the installation is complete you will find TfsMsscciProvider.dll file in the location “C:\Program Files
(x86)\Microsoft Team Foundation Server MSSCCI Provider”.



TFS CONFIGURATION IN QLIKVIEW:
Open QlikView and go to this menu option File>Source Control-> Settings..

File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window H

3 New Crl+ M
% Open.. Ctri+0
#=| OpeninServer... Ctrl+Shift+0

Open URL...

Open FTP...

Close

Favorites >
| Save Ctrl+5

Save As... F12

Mail as Attachment...

Print Sheet...

Source Control » Settings...

Export S Add Project to Source Contral...

Import s Get Project from Source Control...

Edit Script... Ctrl~E
Reload Ctrl+R
Partial Reload Ctrl+Shift+R

s

Reduce Data 3
Table Viewer.. Ctrl+T

g

1 Airline Performance_Original

2 Airline Performance

3 DAQlikPractice\Maps

4 CA\Users\..\comm&2447

5 CA\Users\..\Downloads\Detail

6 C:\Users\..\Downloads\example
7 C\Users\..\Downloads\Gmap[1]
8 CAUsers\..\GoogleMapExampl
Exit

Select “Qlikview Msscci Provider *32” option in the drop down and then click Settings button:

P "

Source Control Settings @

Source Control Providers:
DllikView Msscd Provider *32 v] [ Settings ]

[ aK ] [ Cancel ]

Provide the .dll path in the text box and click ok:

MSSCCI Settings ==

MSSCCI Provider DLL

C:\Program Files (x88) Microsoft Team Foundation Server MSSCCIF []

EoK { [ Cancel ]




ADDING QLIKVIEW FILES TO SOURCE CONTROL:
Start by opening the first document that you wish to add to source control, and select File>Source
Control->Add Project to Source Control:

File | Edit View Selections Layout Settings Bookmarks FReports Tools Obje
3] New CereN It | giig| ¥ | 4] @) 157 i K Clear - |
=y Op=n- o0 o) (A) (=) @) ) (o) @) (O] ¢t 5
E Open in Server... Ctrl+ Shift+ O
W FRefresh Document

Open URL...

Open FTP...

Close

Favorites 3
=l | Save Ctrl+5

Save As... F12
=l Save Link...

Mail as Attachment...

Mail with Bookmark as a Link
—l Print... Ctrl+P
Print Sheet...
L3 Print Preview...
Source Control 4 | Settings...
Export > | Add Project to Source Control...
Import e Get Project from Source Control...

Select the TFS Server name:

Connect to a Team Foundation Server @

Connect to @ Team Foundation Server:

nib=034G55- HEREL - Servers... |
ok | Cancel |

Select the path where you want to place the app in TFS:



Choose Folder in Team Foundation Server @
Specify local and server locations forthe project.
Team Foundation Server Details
Server: nibs03WGSS- HEREL

Folder Location:

=03 B

[ ]

Type a name for the solution folder:

Server path
[s#

Local path:

|D'\OIikF‘mcticeWr|ine Performance-pr

‘Workspace:
[MiBC1840 -] Add...

Once it is done, you will be redirected to below screen, specify the comments if you want and click on “Check In”
button, you can see the files at TFS in “Appname-Prj” folder:

Check In - Source Files - Workspace: NIBC1640 = @I

BEE 0

Source Files || Comment:

& | ;

Wark rems || Name Change | Folder o
(] __\AIIPmparties.xrﬂ\ add D:\QlikPractice\Airline Performance-prj
U ._: CHOB xml add D:\QlikPracticelAirline Performance-prj
Check-in __‘: DocBinary.dat add D:\QlikPractice\Airline Performance-prj
Motes ¥ Doclnternals.xml add D:\QlikPracticeAirline Performance-prj
__\ DocProperties.xm| add D:\QlikPractice\Airline Performance-prj

lj ._: LBO1 xml add D:\QlikPracticelAirline Performance-prj E
glicy __‘: LBOZ.xml add D:\QlikPracticelAirline Performance-prj
Warnings __\ LEO3 2l add D:\QlikPracticeAirline Performance-prj

LBO4.eml add D:\QlikPractice\Airline Performance-prj

. 2 LoadScript.be add D:\QlikPracticelAirline Performance-prj

__: Module.bd add D:\QlikPracticelAirline Performance-prj

Conflicts || 2] QlikViewProjectxml add D\QlikPractice\Airline Performance-prj

__\ SHOLxml add D:\QlikPractice\Airline Performance-prj
I_:Tanaynut.xm\ add D:\QlikPracticelAirline Performance-prj i

el ruae o AR T WS I S R, Y E

CheckIn Cancel

A




RETRIEVING QLIKVIEW FILES FROM SOURCE CONTROL:
To retrieve app data from Source Control we need to select “Get Project from Source Control”:

F'Lle| Edit View Selections Layout Settings Bookmarks Objed
CtreN T | iy | 2 | [# ] @ 12 ] E K Clear - |

«0 g (A ) @) 5 @) @ (@) 64 7 5
Ctrl+Shift+0

Reports  Tools

Mew

Open...

EGL

Open in Server...

Open URL...
Open FTP...

Close

Favorites 3

Save Ctrl+S

Save As...

Mail as Attachment...

Print Sheet...

Source Control Settings...

Export * Add Project to Source Control...

Import > | Get Project from Source Control... |

- O ol O

Once the fetch is done from TFS, the glikview application does not exist. So, we need to create an empty glikview
app to proceed further, the procedure to create qvw file is as follows:

e Create a blank qvw file with the same application name (Map_Test) Map_Test.qvw (Start QlikView, File ->
New, File -> Save As) in folder where Map_Test-prj is placed as shown below:

» MNew Volume (D:) » Demofssets »
ibrary « Share with « Mew folder
MName : Date modified Type Size
, Generic 12/30/201612:03 ...  File folder
| Healthcare 12,/30/201612:03 ... File folder
. Map_Test-prj 12/30/201612:43 ... File folder
, P&CInsurance 12/30/201612:02 ...  File folder
| Retail 12/30/201612:03 ...  File folder
. With Clint Logos 12/30/201612:02 ...  File folder
a| heatrap_visualization_example 12/30/201612:02 ...  QlikView Document 234 KB
12/30/201612:43 ...  QlikView Document 178 KB
a testHeatMaps 12/30/201612:02 ...  QlikView Document 134 KB

e  Click No button when asked to replace the project file in the below window:

QlikView x64

=

I ) project files?

T

, The replaced file was part of a project. Do you want to overwrite the

E3

Yes




e Now, open Map_Test.qvw file in QlikView which will read the contents of the Map_Test-prj folder and

update the Map_Test.qvw file. But to view the data, reload is to be done for the first time.

CHECK-OUT FOR EDIT:
There are two types of check out which are differentiated by lock type:

Lock Typel:

=>» Check out for edit with the lock type as “Unchanged — Keep any existing lock” by 2 users as

shown below:

Check Out ® =]
Files:
Name Folder
v Map_Test-prj  $/DBCOE/Qlik/DemoAssets
Lock type: :.Unchanged - Keep any existing lock M
Checking out local version from source control.
Check Out J Cancel

Local Path: D\Demofssets\Map Test-pr)
Mame & Pending Change | User Latest Last Check-in
v [ AllPropertiesaml edit Ushakiran Gare... Yes 12/30/2016 12...
o BLIO1_800525798 xml edit Ushakiran Gare... Yes 12/30/201612:...
4 @ CHO1 xxmil edit Uzhakiran Gare... Yes 12/30/2016 1:0...
¢ || DocBinary.dat edit Ushakiran Gare... Yes 12/30/2016 12:...
o @ Doclnternalsxml edit Ushakiran Gare.. Yes 12/30/2016 3:5...
v [ DocPropertiesxml edit Ushakiran Gare... Yes 12/30/2016 3:2...
4 LAOL 785638678 xml edit Ushakiran Gare... Yes 12/30/2016 12:...
N LA02 150961321 xml edit Ushakiran Gare... Yes 12/30/2016 12:...
! @ LBO1 xml edit Ushakiran Gare... Yes 12/30/201612:...
7 [l LoadScript.txt edit Ushakiran Gare... Yes 12/30/2016 12...
* B Moduletd edit Ushakiran Gare... Yes 12/30/2016 12....
4 @ QlikViewProjectxml edit Uzhakiran Gare... Yes 12/30/2016 4:2...
! SHO1 .xml edit Ushakiran Gare... Yes 12/30/201612:...
v [ TopLayoutxml edit Ushakiran Gare... Yes 12/30/2016 12....
H @ TX01_696377969 .xml edit Ushakiran Gare... Yes 12/30/2016 4:2...
4 TX02_480816526.xml edit Ushakiran Gare... Yes 12/30/2016 3:1...

=> Both the users can try to edit the application and check-in the code at a time:




o New additions to the application will be added in first window:

Check In - Source Files - Workspace: NIBC1640

@%@v 20

Source Files || Comment:

| -

& i

WorkItems || Name Change | Folder
, ,_\, TH02_480816526.xml add D:\DernoAssets\Map_Test-prj

Check-in
Notes

4

Policy
Warnings

3e
Conflicts

CheckIn I Cancel

4

o Changes done to existing objects are shown in next window:

Check In - Source Files - Workspace: NIBC1640

E"E@- 20

Source Files || Comment:
& | :
Worktems || Name Change | Folder
, ,_, Doclnternals.xml edit D\DemoAssets\Map_Test-prj
U || QlikViewProjectxml edit D:\DemoAssets\Map_Test-prj
Check-in || TX01_696377969.xml edit D:\Demodssets\Map_Test-pr)
Notes
N
Policy
Warnings
3e
Conflicts

CheckIn I Cancel |

4

o The below window pops up when we try to check in same object “TX01_696377969”/
“QlikViewProject.xml” related changes by more than one user, which is a conflict. We need to
resolve it manually by clicking on of the conflicts one after the other:



CheckIn - Conflicts =0 Een ===

v

Work tems

ik AutoResolve All ~ Get All Conflicts @ Refresh [l Compare - €D History -

Source Files ‘ Path Filter applied -I2 Total Conflicts: 2 Version I

| | Mame | Type | Path # | Conflict Type | Description

™

Check-in

-

||.,1- AutoMerge | |\1 Merge Changes In Merge Tool | |E Take Server Version | |i Keep Local Version |

Notes The item content has changed
Content Changes: There are conflicting content changes in the local and the server versions
olj Your Local Version is: 10681 The Server Version is: 10682
Bolicy Changes are: local (edit), server (edit)
Warings | | server edits: 10682

Conflicts

| QlikViewProjectxml §/DBCOE/Qlik/Demodssets/Map_Test-prj  Version The item content has ch...

CheckIn I Cancel

o  When we click on the conflict below window is shown:

3 Accept Merge € 1 M S HB- O-®-9-

1 Conficts (1 R g) | 3 AutoMerged (Server: 3, Lecat 0)
: tmqrm.emmmtcxwﬂ
<Bep enctype="Dasesd"></Bap> </Bap> -

<BkgAlpha>255¢</Bkgalphar <BkgAlphar255¢/Bkgalphar
<Text> <Text>
| aoTeste/v> O <vrTest Appd/vy
</Text> </Text>
<IsageRepresentoticn></InageRepresentation> <ImageRepresentaticn></IsageRepresentation>
<AllowverticalScrollBar>false</AllowverticalScroilBar> <AllowverticalScroliBar>falsec/Al lowverticalScrollBars
<AllowtorizontalScrollBacsfalsec/allomttorfzontalScroliBar> <AllowHorizontalScroliBar>falsec/AlloworfzontalScrollfar
<Actionltess></actionItess) <Actionitessd></acticnitess>
</Layout> </Layout>
<PrintSettings></PrintSettings> <PrintSettings></PrintSettings>
UserSizedstruec/UserSized> <UserSizeditruec/UserSized>
</TextObjectProperties> </TextObjectProperties>
v
00% 4 P 0% 4 ’
Result: TX01 69637796801
<Bep enctypes"boseéd™></Bep> -
<BkgAlpha>255</Bkgalpha>
<Text>
<virTest Appl</vy
</Text>

</TextObjectProperties>

Resolve Conflicts Source Control Bxplorer -

<ImageRepresentation></ImageRepresentation>
<AllowverticalScrollSar>false</allowverticalScrollBary
<AllowMorizoatalScrollBar>false</AllowkorizontalScrollBar>
<ActionItems></ActionItems)

</Laycut>

<PrintSettingsr</PrintSettings>

WserSizedrtruec/UsersSized>

10



o We need to select which changes are to be kept further Right or Left (specified in Green color)
and then click “Accept merge”:

3 Fiescboe Conflicts Source Control Explorer

1 Conflcts (1 Remaining) | 3 Autohlerged [Server: 3, Locak 0)

Server: THD1_GO63TT9680mt C10677 Local: THll 696377965 ami-C10675
<Bmp enctype="basetd™»< Bmps <Bmp enctype="basetd"»< Bap>
<BEgalpha»255</Bkgalpha> cBkgalpha»255</Begalpha>
£Taxts £Texts
[ m L FO T anTest appefy T
""" o Texty o mmmmmmmmmmmmmm——— T Tenny T TTTTmmmmmmmmmm————
¢Imagefepresentation»</Imagefepresentations <ImageRepresentation»</InageRepresentat ion>
<Al lowVerticalScrollBar>fal sed /Al lowVerticalScrollBars <AllowierticalScrollBarsfalse< /Al lowierticalScrollBars
cAllowHorizentalSoral 18ar sfalsec /Al lowHorizontal Scral 1Bar s> <Al lemtHor bzentalScrallBar»falsec /Al lowtiorizontalScral 1Bar
Cict ionItems < fAct iontems > dictionItemsr{ fActionItemss
¢ /Layouts <fLayouty
cPrintsettingsr/Printsettingss cPrimtsettingsrc/PrintSettingss
diseriizedrtruefUsersizeds UserSizedrtroed/Usersizeds
¢ /TextObjectPropertiess «/TextObjectPropertiess
0% = 4 Bl -4 ¥

Renslt: TH0] GO63T7960 0ml
<Bmp enctype="basets™ >/ Bmp>
<Bkgalpha>255</Bkgilpha

STexty
¢ImageRepresentations</ImageRepresentations
cAllowverticalScrollBarsfal sec /Al lowVerticalScral lBar>
<illowHorizentalScrallBar>falsed/allowhorizontalScrollBars
actionItemsr< ActionItems>

</Layout>
cPrintSettings < /PrintSettingis
diserSizedrtroed/UserSized:

</ TextObjectPropertiess

o  We need to check-in conflict related files from TFS after merge as glikview will be showing no
files to be checked-in i.e., project is up-to date:

Eource location: $/DBCOE/Qlik/Demohssets/Map_Test-prj
Folders x Local Path: D:\DemoAssets\Map Test-prj
4 & nibs03\GSS- HEREL || Name = Pending Change User Latest Last Check-in
48 DBCOF [ AllProperties.xml Yes 12/30/201612:...
E Ei’:::;;gﬂ emplates [%1 BUOL_800525798.xml Ves 12/30/2016 12:...
b DashboardsCOC [ CHOL xeml Yes 12/30/2016 1:0...
b Kalido |_| DocBinary.dat Yes 12/30/201612:...
b MSEI [ Dodnternals.axml Mo 12/30/2016 3:5...
b NDS [ DocProperties.xml Yes 12/30/2016 3:
b 1 Necto [ LA01 785638678 xml Ves 12/30/2016 12:...
b ¥ Presales [ 1402 150961321 xml Ves 12/30/2016 12:...
b W Profiles [A LB0L xrnl Ves 12/30/2016 12:...
4 Qlik Bl LoadScript.bt Yes 12/30/201612:...
[ BestPractices Yes
b M Certifications QlikViewProject xm edit Ushakiran Gare... No
b Dashboards [ SHOL xrnl Yes
3 Decathlon [ TopLayoutml Yes
4 @] DemoAssets |+ £ TX01_696377969.xml edit Ushakiran Gare... No 12/30/2016 3:5... |
b [ Generic [ TX02_480816526.xml Yes 12/30/2016 31..
[ Healthcare
Map_Test-prj

11




=>» Once the check-in is completed the application gets refreshed. We may see the below pop-up if it is local
machine and not a Server. We need to click “NO” and proceed:

=

Changing to Server workspace

25|

this workspace to a server workspace?

Yes

The workspace you selected (MIBC2184) is a local workspace. Local
l % workspaces will not work properly in MSSCCL It is recommended to
change this workspace to a server workspace. Do you want to change

Cancel

Lock Type2:

=>» Check out for edit with the lock type as “Check In — Allow other users to check out but prevent

them from checking in” by 2 users as shown below:

Check Qut

Files:

(7 sl

Mame Folder

Map_Test-prj  S/DBCOE/Qlik/DemoAssets

Lock type: | Check In - Allow other users to check out but prevent them from checking in

Checking out local version from source control.

Check Out ] [

Cancel

In this type of scenario, the code gets locked out making other user not to do check-in until and unless the user

who checked out check in the code as shown below:

12



Local Path: D:\DemoAfssets\Map Test-prj

Name = Pending Cha ngel User Latest Last Check-in

o« ]_ﬁ‘l AllProperties.ml lock, edit Ushakiran Gare... Yes 12/30/2016 12-...
s BUO1_800525798 xml lock, edit Ushakiran Gare... Yes 12/320/2016 12:...
+ [ CHO1 xmil lock, edit Ushakiran Gare... Yes 12/30/2016 1:0...
¥ __ DocBinary.dat lock, edit Ushakiran Gare.., Yes 12/30/201612:...
’ Doclnternals.xml lock, edit Ushakiran Gare... Yes 12/30/2016 3:5...
¢ [®) DocProperties.xml lock, edit Ushakiran Gare.., Yes 12/30/2016 3:2...
s E LAD1 785638678 xmil lock, edit Ushakiran Gare... Yes 12/30/2016 12....
! ]@ LAa02 150961321 el lock, edit Ushakiran Gare... Yes 12/30/2016 12-...
s E‘l LEOL xmil lock, edit Ushakiran Gare... Yes 12/30/2016 12:...
+ [B LoadScript.tet lock, edit Ushakiran Gare... Yes 12/30/201612:...
+ B Modulebt lock, edit Ushakiran Gare... Yes 12/30/201612:...
’ QlikViewProject.xml lock, edit Ushakiran Gare... Yes 12/30/2016 4:2...
+ [ 5HOL.xml lock, edit Ushakiran Gare,., Yes 12/30/201612:...
v [ TopLayoutxml lock, edit Ushakiran Gare.. Yes 12/30/2016 12:...
! TX01_696377969 xml lock, edit Ushakiran Gare... Yes 12/30/2016 4:2...
¢ [MTx02_480816526.xml lock, edit Ushakiran Gare... Yes 12/30/2016 3:1...

GENERAL ISSUES AND BEST PRACTICES:

Issue 1: Project already in source control
If a App-prj folder is deleted in source control and checked-in, but it exists in any other user machine, following
error will be displayed:

Source Control

h Project is already in source control, Use Check In operation to update
#' the source control files,

Best Practices:

=>» Clean up the TFS temp files related to the App-prj (project) folder from Server.
=» Rename the app and do a check-in.



Issue 2: Incorrect TFS mapping
If the local mapping for TFS is wrong, we will not be able to see the options highlighted as below:

File | Edit VWiew Selections Layout Settings Bookmarks Reports Tools  Ohbjg
3] New cienN ) | ol e | 4 ] @) L2 i K Clear - |

=4 Open... Cte v (2] (A (=] = 3] (@) @) (=) ] i F =
5 Open in Server... Ctrl+Shift+ 0O

Refresh Document

Open URL...

Open FTP...

Close

Favorites 3
=l Save Ctrl+5S

Save As.. Fi2

=2l Sawve Lin

Mail as Attachment...

ail with Bookmark as a Link

Print Sheet...

t Preview

Source Control > ” Settings...

Export ¥ Add Project to Source Control...

Import C Get Project from Source Control...

Edit Script... Ctri+E
Reload Ctrl+R
Partial Reload Ctrl+Shift+R
Reduce Data >
Table Viewer... Cirl+T

LE

uHLu

Best Practice:

=>» Remap the projects to the correct location in TFS and get the latest version of the app from QlikView

desktop.

4 phAccet T

I+ Gen @) Get Latest Version

b m ok out for Edt..

May

b pcil X Delete

B Ret: Rename

b Wit Move...
b i Financi - polipack...
I Hierarc R
b Mailers 2 Undo Pending Changes...
I Mashug & CheckIn Pending Changes
3 Micros| . Shelve Pending Changes
b NPrint D View History Get Specific Version...
I Pre_Sali
b Predict| & Compare... Lock...
b O QAP | %5 New Folder Unlock
4 QlikMa Y AddItemsto Folder... Apply Label...
b QlikPrig
b QlikRes Branching and Merging 4 Security...
I QlikSen Find » | & Properties..
b Qlfkl"‘.le‘ Advanced » | 55 | Remove Mappin
b QlikVsTl I




Issue 3: Empty Qlikview App Creation at incorrect location
This scenario may occur in few scenarios, when an empty glikview application is created elsewhere rather than the
Source control mapping folder. The app still remains empty, not showing the objects.

Best Practice:

=>» Create a new app in the Source control mapping folder instead of creating it some other location and
copying it.

Issue 4: Document addition to Source Control

In menu option there is the add project to source control enabled, but when clicked on it nothing happens, and the
usual pop up window doesn't appear. A -prj folder is created in the folder where the document is stored, but it is
empty. Any attempts afterwards to add it to source control result in an error saying that it cannot find the Qlikview
Project file in the -prj folder.

Best Practices:

= Delete the -prj folder and save the application.
=>» Re-create the application.

Reference: https://community.qglik.com/thread/215848
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